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Public Transport Services

A Division of SA Government’s Department of Planning, Transport and
Infrastructure (DPTI). Manages Adelaide’s public transport network

e Over 500
services / d

e 100+ railcars
¢ 300 km track
e 84 Stations

Over 200
services / d

22 trams
28 Stops
35 Km track

e Over 60m
trips/y
e 9m Train

3mTram
48m Bus

services /d

e 1145
Busses

e 8303 bus
stops

Train Services;
Tram Services| g
Total servicesj
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Rail Revitalisation Projects

30 years of little investment

SA Government’s $3 billion ten year commitment was the biggest single
investment ever in public transport in SA.

The majority of the investment was to revitalise Adelaide’s passenger rail
network.

Upgrades include:

* Track upgrade * Overhaul of several train stations
* Extending Noarlunga line to Seaford e Increased services
* Electrification of Seaford line  Tramline extension (to Entertainment

* New electric Trains & Trams (larger fleet) Centre)
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Enhancing the PTS AMS

Organisation

80% of all your potential (AMS) improvements could and are most
likely related to Process and Organisation.

Q: How can an organisation and it’s processes be enhanced
(_through increased system functionality?
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Systems integrated functions

Asset and
Work
Management
System

Document
Management
System

Geospatial
Information
System
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Systems integrated functions

Asset and
Work

Transit Performance Management Property Location Browser

System

Train Notices Landmarks
Document Geospatial
Management Information
Network ACCGSS ST S Network D|ag ram
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Maximo with Linear and Spatial

*Spatial Analysis
ESRI *Map Production
ArcGlIS Bulk GIS Data Creation

\ *Corporate GIS Layers

Corporate GIS Maximo \WEN el -Data with length
*Define Work Zones sLinear Features

«Spatial location Spatial sLinear attributes
*Reference points

'




What Maximo Linear does?

* Discrete assets/work orders/service requests

@ a location, can have (or can be) child assets

* Linear assets/work orders/service requests

Has length (or exists along a line). Assets can be segmented using features, and can have
attributes, reference points and relationships.
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What Maximo Linear does?

Reference
Point

Assembly

Point assets structure

=g =
|

linear assets
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List Asset Spare Parts Safety Meters Specifications Features Relationships Work Topology Map Semvice Address

Asset: 40011 Track - Main - North Down Main o+ Site: HRAIL From 0.000 To 40.289

0 You can filter to view only the relationships where the current asset is the source or the target. You also can view all relationships

Filter By View Al |~

Relationships I) Filter S : J} 1-60f72 df 4 Download

Sequence * Source Asset Source Description Source Start Measure Source End Measure Relationship Target Asset Target Description Target Start Measure Target End Measure
3 40011 »» Track - Main - North Down Main 10.185 10.185 BELONGS TO 27 40491 2» Turnout : DC31 10.185 10.185
» 40011 »» Track - Main - North Down Main 13.397 13.397 BELONGS TO > 40485 »» Tumout : DC126A 13.397 13.397
» 40011 »» Track - Main - North Down Main 13.388 13.388 BELONGS TO »» 40480 »» Tumout : DC125 13.388 13.388
b 40011 »» Track - Main - North Down Main 1.329 1.329 BELONGS TO > 40451 »» Turnout : AD83 1.329 1.329
b 40011 »» Track - Main - North Down Main 0.687 0.687 BELONGS TO »» 40410 »» Tumout : AD69A 0.687 0.687
» 40011 »» Track - Main - North Down Main 0.423 0.423 BELONGS TO »» 40394 »» Tumout : AD59A 0.423 0.423

New Row

0 Use the slider control below the graph to change the start and end measures and to zoom in. Drag the graph to scroll. More information
@ () Specifications A A
@ ) Work
(=) (= Relationships
BELONGS TO L I T I T . -~ T s . T I O O . T . 3K

# () Features
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List Asset
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Spare Parts Safety Meters Specifications Features Relationships Work Topology

Senice Address

Asset: 40011 Track - Main - North Down Main .:l Site: HRAIL From: 0.000 To: 40.289
Features PFiter > O & U ¥ (1-100f79 P 4 Download = =
Feature Description Label Type Start Measure * End Measure Share With Related Assets? On Related Asset?
j » >5 <15 Q
) BELONGS TO »»  An asset that is part of another KM Post - 5 (40839) LINEAR 5.001 5.001 [¥ ] @
‘ 7/ BELONGSTO »» An asset that is part of another Tumnout - IG1A (40709) LINEAR 5.158 5.158 Ll @
| » BELONGS TO »  An asset that is part of another Level Crossing - Pym Street (41333) LINEAR 5.237 5.237 [ # @
‘ D BELONGS TO »»  An asset that is part of another Pedestrian Crossing - Pym Street - Down (40940) LINEAR 5.250 5250 [ 4} @
‘ P RALSIGNAL 3 Signal Signal - 574 - A POINT 5.261 5261 [ [l *@
‘ p RAILSIGNAL 3> Signal Signal - 573 POINT 5.438 5438 [ @
p RALSIGNAL 3  Signal Signal - 672 POINT 5516 5516 [ # @
[ RAILSIGNAL 3>  Signal Signal - 671-A POINT 5537 5537 [ [} @
‘ D BELONGS TO »»  An asset that is part of another Speed Zone - 80km/h (40643) LINEAR 5543 5543 [v] = @
[ RALSIGNAL »» Signal Signal - 674 - A POINT 5.865 5.865 [¥ 4 @
| Feature Details
Feature: BELONGS TO 7> An asset that is part of another ) On Related Asset?|
Label: Tumnout - IG1A (40709) Continuous?|
Type: LINEAR Share With Related Assets?|v'
Classification: » Is Reference Point?[v
Class Description: @ Created by Relationship?|
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Asset: 40010 rack - Main - North Up Main| L,Jv Site: HRAIL ] Fron|
Common Asset Name: North Up Main
Classification: 1.0 ADELAIDE PUBLIC TRANSPORT SYSTEM \ 2.0 ADELAIDE »» (lass Descnphion:Ral Q
Specifications [ Fiter > (1 " < G 1-190f243 P
Attribute = Description Data Type Alphanumeric Value Numeric Value Unit of Measure Table Value
[P FASTENING SYSTEM | Fastening SystemALN  Trak Lok 1 <. | o o
| FASTENING SYSTEM (), Fastening System ALN F&Gs Q Q Q
|p FASTENING SYSTEM (Z), Fastening System ALN Dog Spikes Q Q @
v evrserene = . —— = -~

0 Use the slider control below the graph to change the start and end measures and to zoom in. Drag the graph to scroll. More information
FASTENING SYSTEM [4] 8
FASTENING SYSTEM [
RaL e - T R p— S o
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SLEEPER TYPE Concrete [ Concrete Concrete | Steel Con o Steel
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l List “ Asset H Spare Parts ], Safety “ Meters “ Specifications “ Features ” Relationships u Work \l Topology “ Map |i Senvice Address l

Asset: 40136 Corridor - Outer Harbor = Site: HRAIL From: 15663 To: 22125
Common Asset Name: Outer Harbor Corridor
Classification: 1.0 ADELAIDE PUBLIC TRANSPORT SYSTEM \ 2.0 ADELAIDE > Class Description: Corridors / Land Q
Specifications [ Fiter > _ 1~ . ;<1 CZ0-00f0 £ Download ;= I
Attribute ~ Description Data Type Alphanumeric Value Numeric Value Unit of Measure Table Value Start Measure * End Measure

...No rows to display..

e Use the slider control below the graph to change the start and end measures and to zoom in. Drag the graph to scroll. More information

B0 316519 n " g 10 1
@ (] 309867 " Station Clean 2647 - 9.276 (OUTH) |
@ () 316533 Station Clean 10.173 - 15,628 (OUTH)
@ 316550 Station Clean 2.647 - 9.276 (OUTH) |
@ () 309697 Call Out
@) 315634 dsus...

@[ 328624 L Call Out Gang W boards left up.
ey
) 354234 Viaduct - Port Adelaide Viad...

@ () 370788 ;un Rail - Inspection (Outer Harbour)
o 373149 I

o 374216 ( Port Dock ) Broken Bott in Joint R\R

B 374218 [ { Port Dock ) Cripple nsert RIR
B 374619
B () 359060

@ () 359074 Station Clean 10.173 - 15.528 (OUTH)
@ () 359091 Station Clean 2.647 - 9.276 (OUTH)
& () 356726
@ (5 358977

[ 351057

[l

1.563 22125
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Search for Work Orders

Start Measure:

Owner Group: Q
End Measure:
: S
Corridor: Q Work Type: 4
(_Reser )
@), advanceasearen ¥ [ ssvequery ¥ || Bookmarks
| WorkOrders rmer - O g & @ . 1-20087 P 04 Rewnicad -l
| Work Order Rescription Common Asset Hame Schedyled Starg ‘Corridor Briorky Slatus Slart Meas = Eod Weas !
| out =t «® @ >s <19 |
403372 Insulation Pads Outer Harbor Corridor S/04/14 1:30 PM OUTH 20 comP 5050 5200 l“ |
417387 ot IW on 0N Mok Outer Harbor Up Line ouTH 20 APPR £.080 so4s O |
201870 14316 Tight gauge 12mm Outer Harbor Up Line 18/11/13 3:00 P ouTH 2c WPRG 5.093 soes Iy |
382738 Cal Out Croydon West Subway OUTH 1 comMP 5.089 sose By ’
|
loose rubber mats under rad loose on |
364159 ot il tarierdy Rosetta Street Bridge ouTH 20 APPR 5108 s106 S |
(Re-insulate Rossetta street )
347681 Bridge) Rosetta Street Brdge 1110713 1110 AM ou™ OMP Ss.108 S$.106 ‘“ I
|
7457 Vertical misalignment (Defect
200022 B Outer Harbor Up Line oumH 20 APPR s120 soso . |
11267 Damage “ | J " head of
230406 bt pers- Outer Harbor Down Line ouTH 2 APPR 5180 s1e1 O !
218980 Mudhole forming on the up track tamping Outer Harbor Up Line 13110113 8:30 AM ouTH 20 WNPRG 5260 s260 4 l
Fill n walk in holes - ref. Mark ¥ |
392628 Hetherington Outer Harbor Cornaor 22/0014 7:30 AM QuUTH comp 5.280 $.280 % l
Bitumen breaking up In walkway, tripping |
318983 hazard. bfumen required to fil In Outer Harbor Up Line 16/06413 1:00 PM ouTH 20 comp 5280 s280 S
hole.Require tamping.
|
201311 IR083 17w butak (Ao repart Outer Harbor Up Line 210213 1210 PM ouTH 20 comp 5.280 5250 O |
330402 Btumen raised in wakway on up track Outer Harbor Up Line 31013 8:00 AM OUTH 20 cOomMP 5.329 $.330 % I
393580 Btumen in wak way breaking, Up track Outer Marbor Up Line oum™ 2Cc cCOomP $.330 $.332 “ I
200826 11882 msutficient ballast Outer Harbor Down Line ouTH 20 APPR s970 so002 My |
201888 14315 Tight gauge 11mm Outer Harbor Up Line 181113 3:00 PM ouTH 20 HPRG €.000 so00 Ny |
12298 rodundant Ljs adelakie side of |
270944 Ssadipirrich Outer Harbor Up Line outH 20 APPR 8.040 8040 Dy [
10166 Raised btumen surface on roadway
200300 update 311/ 2011 k.maskn 2D hole in Kikenny Road Level Crossing OUTH 20 comp 6049 8049 -k
beumen rest of r-xing
240371 o chack ot ey Outer Harbor Corridor ouTH F mPRG 6.050 s0s0 By |
| ] Select Records
- € Local intranet | Protected Mode: Off a - W|105% =~



Heavy Rail WO

* Owner Group: TRACK Q Ciass: [WORKORDER | Status: BPRG | see: [WRAL | Attachments [
inspection Priorty: 20 | 4 Speed == Work Speed Restriction: Q Is Report Printed?: |
Work Order: (201870 | 14316 Tight gauge 12mm | 68
Work Type: CM -
Asset 40119 >> [Track - Main - Outer Harbor Up Line =
g T |
incident Class: TRACK INSPECTION FAULTS \ TRACK GEOMETRY \ ALGNMENT 3> [Asgnment ]
Failure Class: HRAIL-FO03 | > L
Start| Ena I sessl [ sos
MM
Start End
Reference Point Bridge - Rosetta Street Bridge - Radl over Road (41348) | » Reference Point  Bridge - Rosetta Street Bridge - Rail over Road (41348) >
Reference Point Offset -13.000 METRES Reference Point Offset -13.000 |
Measure: soe3 [k ] weasure: | - oo T T
¥ Offaet | ] ¥ Offaet: | | =
¥ Reference: ] ¥ Reference: |
ZOttaet: | I Zoftset: | ]
Z Reference: | Z Reference: | ]
w
Target Start: [ o Scheduled Start: 1811713 3:00 PM | OB Actual Start: 20111713 11:25 AM & 5)
Target Finish: | i ) Scheduled Finish: 18/11/13 3:00 PM | B Actusl Finish: 1. )

No rows to dmplay.
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What Maximo Spatial does?

e Ties an asset, work order or service request to a
spatial location (point, line or polygon feature).

 Terminology difference between a Maximo Feature
and a Spatial Feature.

e A spatial dataset within ArcGIS is referred to as a
Feature Class. A Feature Class contains features

e Features can be Points, Lines or Polygon
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List Work Order Pians Assignments Related Records. Actuals Safety Plan Log Fadure Reporting Specifications [ Map Service Address Audit Dats

Work Order: | 242316 Callout by Tram control to Glandore 1o remove offensive Graffai |+ Status: | COMP Feature Class' PTASSET_WORKORDER R Altachments oo
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A planning use case b

A priority 1 work order comes in through Maximo.

Planner organises immediate dispatch of crew to fix fault. Planner then
interrogates the system for surrounding faults

Planner uses the spatial select tool to drag a 500m radius around the work
site and identifies 20 jobs.

He pushes the selected work orders into the list screen, and filters by owner

group, picking up 3 additional work orders that can be completed by the
dispatched crew.

He then assigns additional work to the crew, to be completed after rectifying
the high priority fault.

\_ The crews view and complete assigned work orders using toughbooks.
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Expanding Linear and Spatial functionality

e ArcGIS is capable of converting linear information (i.e
chainage) into point or line features.

* This allows for linear work orders to be displayed
spatially.

e Although Maximo Spatial is capable of linking to the
asset at fault, it can not spatially identify the linear
section of an asset at fault.
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List Work Order Plans Related Record: Actuals Safety Plan Log Failure Reporting Specifications. Map Service Address Audit Data

Work Order: | 372984 + Status: APPR Feature Class: (] Aftachments [Z9
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Generation of Spatial features from Linear’

Information
e References the Maximo WORKORDER table

* Prepares data within ArcGIS for linear referencing
e Creates GIS Features from linear information

e Pushes updated features into the Work Order
Feature Class

* Updates Maximo Work Order table via MIF




WO_Table / / Roue Fée /
(Table) Featire Clann)

Automated Work Order update
process (Pt. 1): Data Preparation

(v1, 20006/2014)

Automated Work Order update
process (Pt 2): Database Update

(v1, 20/05/2014)




A basic example of the work order
output

With the availability of Maximo tables through
the SDE, the potential for analysis and
interrogation is virtually endless.

Example: Work orders displayed by length.




Work Order Length
e 0 - 80m

e 80 - 250m

250 - 515m

515 - 950m

950 - 3233m

Rail

0 10 Kilometers 200 100 0 200 Meters

Overview of the AMPRN - Work Orders (Symbolised by Length)
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Spatial analysis
and statistics

*Nearest Neighbour Analysis
*Density Analysis
*Weighted Density Analysis

= @ Spatial Analyst Tools
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& Conditional
& Density
“ Kernel Density
Line Density
Point Density
ance
, Corridor
. Cost Allocation
Cost Back Link
Cost Distance
. Cost Path
» Euclidean Allocation
 Euclidean Direction
. Euclidean Distance
» Path Distance
Path Distance Allocation
. Path Distance Back Link
& Extraction
&+ Generalization
& Groundwater
& Hydrology
& Interpolation

4

AAAMAAMAAAAN D A A

“ Iow

- . Kriging

“ Natural Neighbor
“ Spline

Spline with Barriers
» Topo to Raster
» Topo to Raster by File
» Trend
Local
Map Algebra
Math
Multivariate
Neighborhood
Overlay
Raster Creation
Reclass
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Solar Radiation
Surface

& Zonal

=) @ Spatial Statistics Tools
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%3 Analyzing Patterns
&7 Average Nearest Neighbor
%" High/Low Clustering (Getis-Ord General G)
5’ Incremental Spatial Autocorrelation
&' Multi-Distance Spatial Cluster Analysis (Ripleys K Function)
;;' Spatial Autocorrelation (Morans I)
& Mapping Clusters
& Measuring Geographic Distributions
& Modeling Spatial Relationships




verage Nearest Neighbour Analysis

Significance Level Critical Value

(p—value) (z-score)
001 gmm <-2.58
0.05 @ -2.58--1.96
0.10 [ -1.96--1.65
= ) -1.65-1.65
0.10 3 1.6S5 - 1.96
0.0s @@ 1.96 - 2.58 .
0.01 EE >258 Average Nearest Neighbor Summary
Ob ved M Dist e: 20.7903 Meters
Expected Mean Distance: 392.9702 Meters
Nearest Neighbor Ratio: 0.052905
z-score: -83.895101
<—| .—
p-value: 0.000000
Significant Significant
Dataset Information
Input Feature Class: PTASSET.WORKORDER_POINT_MAP_V
. Distance Method: EUCLIDEAN

Study Area: 1324353827.584769
’ = = = Selection Set: True
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PTASSET.W...

0-
14.06422594

14.06422595 -
28.12845188

28.12845189 -
42.19267782

42.19267783 -
56.25690375

56.25690376 -
70.32112969

70.3211297 -
84.38535563

84.38535564 -
98.44958157

98.44958158 -
112.5138075

112.5138076 -
126.5780334

Date: 5/06/2014
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Density Anaylsis
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Open Faults Density Analysis Open Faults Kernel Density Analysis
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Questions
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